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Course Highlights 
 Eliminate duplicate data entry and trim valuable minutes from every report 

 Tap into your XSite to start new appraisals in the field 

 Capture and proof photos on site 
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Introduction to Field Data Collection with Pocket TOTAL 

 

Introduction to Field Data Collection with Pocket 
TOTAL 

Collecting data in the field is one of the most time consuming tasks faced 

by appraisers.  Often, this is compounded by the need for entering data 

twice – once on a paper inspection form, then again into a form-filling 

application.  But mobile tools like Pocket TOTAL have eliminated this 

duplicate data entry and improved the overall process of field inspections.  

Using Pocket TOTAL, you can complete a property inspection, entering 

the specific data as you go along.  Mobile Sketch allows you to complete 

the sketch before you leave the property, ensuring that all dimensions 

have been collected.  Arriving back at the office, this data is synchronized 

with a desktop system where the appraisal report can be completed in 

record time. 

Hardware Requirements 

Pocket TOTAL and Mobile Sketch are developed for the Pocket PC 

platform running Microsoft’s Windows Mobile operating system.  At a 

minimum, your device should have 32MB of memory, though 64MB is 

recommended to allow ample room for storing reports.  Some other 

options to consider are: 

 Bluetooth technology connects your device with other mobile tools 

like phones, global positioning systems and Disto laser measuring 

devices. 

 Wi-Fi technology gives you access to wireless networks and public 

hot spots.   

 Ruggedized devices are specially built to withstand extremes of 

temperature, moisture and hard knocks.   

 Transflective displays ensure that you’ll be able to use your device in 

bright sunshine as well as dark hallways. 

 Extra batteries and chargers come in handy when you’re trying to 

squeeze in one more inspection at the end of the day. 

 

Copying the program to your Pocket PC 
Since the Pocket TOTAL setup files are copied to your desktop PC at the 

time WinTOTAL is installed, there’s no need for a separate CD.  

Everything is done through WinTOTAL. 

1. On your Pocket PC, close any programs that may currently be 

running and could interfere with the installation. 

2. Connect your Pocket PC to your desktop computer and start the 

ActiveSync utility provided with your device. 
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3. Go to WinTOTAL’s Appraisal Desktop and click the Pocket TOTAL 

shortcut. 

4. Click Install Pocket TOTAL from the list of options on the left side 

of the screen. 

It may take several minutes for the program to be copied to your Pocket 

PC.  Just follow the instructions as they appear on screen to register 

Pocket TOTAL and Mobile Sketch.   

The install program creates an icon for you in your Pocket PCs Start 

menu.  To start Pocket TOTAL, simply tap Start, Programs, and then 

the icon for Pocket TOTAL. 

Getting updates to Pocket TOTAL 
Updates to Pocket TOTAL are delivered right along with WinTOTAL 

updates.  Just as reports are synchronized, updates will be synchronized 

as well upon establishing a connection between your Pocket PC and 

desktop computer. 

Pocket TOTAL Report Manager 
By default, the Pocket TOTAL 

Report Manager will be 

displayed first.  The Report 

Manager is your virtual file 

cabinet for your reports.  Just as 

in WinTOTAL, you should create 

additional folders to store 

reports and templates.  To 

create new folders, do the 

following: 

1. Bring up the Report 

Manager window.  It 

loads when you first 

start the program.  It 

can also be accessed while in a report by tapping the File menu and 

choosing Open. 

2. Tap the Folders menu and choose New. 

3. Type the name of the new folder, and tap OK. 

There are several other items you can use in the Folders menu to 

manage your folders.  These operations work on the currently selected 

folder. 

 Use the Rename option to give a folder a new name. 

 The Delete function removes a folder and all of its contents. 

 The Refresh function is supplied for rare situations when a report 

may be copied into a folder in a background operation like EDI. 

Moving and copying reports 

To move or copy a file from one folder to another, do the following: 

1. Tap on the file you wish to move or copy. 

2. Tap the File menu and choose Move or Copy. 

3. Once the File Move or Copy dialog appears, select whether you 

want to move the file or copy it.   

4. Then, select the destination folder from the drop-down list. 

5. Tap OK. 

The “Synchronized” folder  

When you installed Pocket TOTAL, a Synchronized folder was created in 

your WinTOTAL File Cabinet and in Pocket TOTAL’s Report Manager.  

Simply move or copy any file you wish to transfer to the other system 

into the Synchronized folder and it will be transferred next time you 

connect - even if WinTOTAL isn’t running.   

You can also configure individual folders as the “synch” folder for each 

user.  In the Appraisal Desktop, just right click on the folder and choose 

the “assign” option. 
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Creating new files 

There are several ways to start a new report for Pocket TOTAL. 

Starting files in WinTOTAL.  This is the recommended way since you 

can clone a template and already have portions of the report pre-filled.  

Create it just as you would any other request.  When you’re done, drag 

the file into the Synchronized folder.  The next time you connect your 

Pocket PC to your system, it will be copied to the Pocket PC. 

Creating new files in Pocket TOTAL.  Once you have started Pocket 

TOTAL, simply tap File and then New to start a new report.  Or, tap the 

new document icon in Pocket TOTAL’s toolbar.  You will be prompted for 

the report name, the form type and folder for the report.  When this 

report gets back to the desktop, you will need to add the rest of the 

supporting forms. 

Copying existing Pocket TOTAL files.  You can copy an existing 

Pocket TOTAL report by highlighting it and using the Copy command 

from the Report Manager’s File menu.  This is handy if you have 

templates stored on the Pocket PC. 

Exporting a report from your XSite.  Access your XSite through your 

hand-held device.  While viewing the Order Details, you can click the 

Pocket TOTAL link and the order information is sent directly to a new 

Pocket TOTAL file. 

 Note:  WinTOTAL and Pocket TOTAL will always synchronize files that are 
stored in either system’s Synchronized folder. 

 

Loading an existing file 

1. If the Report Manager is not currently in view, tap File, then 

Open. 

2. To get to the correct folder, simply tap it with the stylus.   

3. Double tap the file you want to load. 

Shortcuts in the Report Manager 

Here are some shortcuts to make easier work of functions in the Report 

Manager. 

 The File menu contains a Most Recently Used list of the last four 

files used.  This is a quick way to get to a current project. 

 To delete a file, tap it once.  Then click the X button in the toolbar. 

 To delete a folder, highlight it and then either go to the Folder 

menu, and click Delete or click the folder with the red X button in 

the toolbar.   

 Note:  The “reports” and the “synchronize” folders can not be deleted. 

 If double-tapping is awkward, you can open a report by tapping it 

once and then tapping the icon resembling an open folder. 

Data entry  
The Pocket TOTAL data entry 

environment is segmented 

into PowerViews.  Each 

PowerView contains

functions related to a 

particular portion of the 

report.  To activate a 

particular PowerView, just 

tap once on the PowerView 

menu, and tap the

PowerView of your choice.  

Certain functions such as: 

New, Open, Save, Options 

and Help are available 

regardless of the currently 

active PowerView. 
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Typing into fields 

Typing in Pocket TOTAL primarily takes place in the Form PowerView. 

There are several different ways to “type” information that isn’t already 

in a QuickList:  Character recognizer (recommended), Block 

recognizer (old Palm-style), Transcriber (takes practice), and 

Keyboard (slow, but reliable). 

 Moving through fields - Use the blue arrows to move between 

sections.  Tap on the down green arrow to move to the next field.  

Tap on the up green arrow to move to the previous field. 

 Jump to sections - Below the main form to the left of the blue 

arrows is a drop-down menu which takes you quickly to any section 

of the form.  This is the fastest way to get around. 

 Visible fields list - Tap this drop-down (located between the blue 

and green arrows) to filter your list of fields to cause the green 

arrows to move through All Fields available in the form, all Critical 

Fields which you must get while on site or the Empty Critical 

Fields only.  You can even customize the field list to show as many 

or few items while in the field.  This is described in the “Custom 

Critical Fields” section below. 

QuickList comments 

QuickLists are the key to the effective use of Pocket TOTAL.  Using them, 

you can quickly move through the form without having to type data.  

Simply pick the items from drop-down lists that appear when you move 

into a field.   

Pocket TOTAL’s QuickLists work in a manner similar to the way they work 

in WinTOTAL.  When the program is installed, your comments are 

transferred over automatically.  When you get to a field where QuickLists 

are defined, you’ll see them in a pop-up window, or you’ll see a button 

indicating the QuickList is there.  Simply tap an entry to use it.  

 

To choose whether the 

QuickLists show up as a 

button or a list: 

1. Tap File, then 

Options.  The 

options dialog 

will open.   

2. At the bottom of 

the dialog, tap 

the radio button 

for Show 

Button or

Show List, 

then tap OK.   

 

You may add QuickList 

entries on your Pocket 

PC by using your stylus 

to tap and hold a text entry.  When the window pops up on your screen, 

simply tap QuickList + to add the text entry to your QuickList. 

Cut, Copy and Paste 

The ability to Cut, Copy and Paste is provided in the Edit menu to 

speed your data entry.  You may also access these functions by using 

your stylus to tap and hold the text (or the empty field) you’d like to Cut, 

Copy or Paste into.  When the window pops up on your screen, tap the 

appropriate function, and it will be performed.  The Cut tool is handy for 

clearing an entire field.   

Checkboxes and picklists 

Data may be entered into checkboxes by simply tapping in the data entry 

field.  For an example of a checkbox field, try the Predominant 

Occupancy fields in the Neighborhood section.  Certain fields have 

predefined picklists, such as the Marketing Time field. 
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Critical fields 

The idea behind Pocket TOTAL is to not only save you time, but also 

make sure your data entry is accurate and complete.  Critical fields 

facilitate that goal by visually indicating fields that haven’t yet been 

completed.   

 Instead of clicking in a field to enter data, the green arrows at the 

lower right of the screen will skip you to the next critical field. 

 The Critical drop-down configures how those green arrows operate.  

Your options are:  All Fields, Critical Fields, and Empty Critical 

Fields. 

Critical fields may be customized through an application on your desktop.  

Further, entire forms can be customized to fit your workflow with our 

Pocket Genie utility. 

Digital Photos on a Pocket PC 
Pocket TOTAL has the 

ability for you to read 

images from a Pocket PC 

camera or your card’s 

internal memory.  This 

feature is useful in 

situations where you are 

out of memory on your 

card or if remembering 

which property went with 

each photo is an issue.  

In order to use this 

feature, you must have 

the following: 

 A camera that stores 

images on media 

compatible with your 

Pocket PC, such as a Compact Flash (CF) or Secure Digital (SD) card.  

 The camera should be configured to save images in the JPEG format. 

 Finally, you’ll need a Pocket PC with a CF, SD or some other slot that 

reads what your camera takes.  You may need to purchase an 

inexpensive adapter for your camera’s memory card in case the slot 

on your Pocket PC is for a different type of media. 

Reading images from the memory card 

The Pocket PC operating system has a built-in understanding of memory 

cards.  It uses them in much the same way your desktop PC uses floppy 

disks.  In fact, the same memory cards sold for digital cameras are also 

sold as external storage for many Pocket PCs. 

When you switch to the Photos PowerView, the Image Folder label 

displays the last used image directory.   

 On the left side of the screen the image files in that directory are 

displayed.  If the Image Folder is not correct or no image files are 

in the directory, click the camera icon, choose Folder/Card and 

select the correct folder.   

 You may find that you need to back up several levels to get to the 

additional drive representing your memory card.  To do so, click the 

plus (+) sign to expand the folder list. 

 Many digital cameras store digital photos in directories on the card.  

For example, the Kodak digital cameras allow you to create photo 

albums and subsequently put each photo in the album in a separate 

directory. 

Previewing and placing photos 

Pocket TOTAL gives you the ability to preview photos stored on a 

memory card or on your Pocket PC before placing them in a report. 

While in the Photos PowerView, tap the image and make sure Show 

Preview is marked.  Double-tapping the preview opens up the image in 
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the Pocket PC’s browser, so you can see it in more detail.  Just close the 

browser when you are through viewing the image. 

To place an image in your report, click the drop-down and choose the 

page, then click the image from the list and then click the arrow. 

Synchronizing images embedded in Pocket TOTAL files 

When images are used in a Pocket TOTAL report, they will only be 

synchronized one time - inserted into appropriate photo pages in the 

report.   

Additionally, the images on the Pocket PC take precedence over any 

images already in the report.  After the file is copied to your desktop 

system, the images are removed from the file on the Pocket PC. 

 Note: For your convenience, all photos are automatically added to your 
photos database. 

Freeform Notes and Drawings 
Use Pocket TOTAL’s FieldPad PowerViewto do quick free-form sketches 

of the inside walls of a property, special buildings on the land or other 

items you’d like to make quick drawings of to use later.  There are 

several ways to use the FieldPad: 

Standard text/keyboard entry - Tap the blue T to move into standard 

text/keyboard entry mode.  Then, tap the bottom right arrow to choose 

your method of text entry.  Once you have finished entering your text, 

click the pencil icon to return to drawing mode. 

Free-form drawing - Use your stylus as a pen to begin drawing in the 

FieldPad.  You may change the width and color of the lines you draw by 

tapping the color button just to the right of the T icon. 

Selecting, moving and resizing drawings - You can select or 

“highlight” your drawing by tapping the icon that looks like a dotted 

square (the third icon from the left).  Once selected, your drawing will be 

surrounded a box made up of squares and circles.  These are called 

“handles.” Tap and hold one of the square handles on the corner of the 

drawing, and then drag your cursor across the screen to rescale your 

drawing.  Tap and hold one of the circle handles and then drag your 

cursor across the screen to resize the drawing from that side only.  (In 

this case, the drawing will not be rescaled but will be resized 

disproportionately.) To move the drawing, tap once in the center of the 

“highlighted” drawing, and drag your cursor. 

 

Undo and redo - You can use the icon on the far left to undo your 

previously drawn lines.  Each time you tap it, it will undo one line.  Use 

the icon to its right to redo your previously drawn lines.  Each time you 
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tap this icon, it will redo one line.  Consider this function when drawing 

and raise your stylus often to give you more undo/redo options.   

Zoom in and zoom out – Just tap the magnifying glasses at the bottom 

of the screen.  Tap the icon with the plus (+) sign to zoom in.  Tap the 

icon with the minus (-) sign to zoom out. 

Capture Voice Notes 
Pocket TOTAL uses audio capabilities native to the Pocket PC to record 

WAV files right into your report.  The benefit is that you can have your 

live voice embedded in the report for dictation or for recall if you need to 

open the report for review sometime in the future. 

 Multiple files may be recorded into the same inspection. 

 The WAV files are only voice quality, so several hours, if needed, 

may be recorded. 

 To save space, the audio files are removed from the PPC after the 

file is copied over to the desktop. 

 The audio files are playable through WinTOTAL’s Workfile. 

Making an audio recording 

Here is how you record voice notes in the field: 

1. Tap PowerView on the Pocket PC and select VoicePad. 

2. Tap the red Record button. 

3. Speak into your PPC’s built in microphone. 

4. Tap Stop. 

5. Preview the recoding by tapping the Play button. 

Mobile Sketch 
A great benefit to data entry in the field is being able to sketch your floor 

plan and calculate areas right on site using our exclusive partnership with 

Apex. 

Mobile Sketch works much the same as Apex IV Windows, and once 

you’ve synced with your desktop PC, the sketches you create with it will 

be fully editable so you can add finishing touches back at the office. 

 Use the Define function to start new perimeters. 

 Raise and lower the pen with the ENTER key. 

 Lines are drawn by typing the dimension and direction and then 

tapping Enter. 

 Arc capabilities are accessed by tapping (). 

 Remove and retrace lines via DEL and INS. 

 Auto-close areas using the Close item. 

 Pop to walls and corners using the CTRL function. 

 Zoom in and out using the +/- keys. 

 Use the Objects item from the Draw menu for predefined circles, 

boxes, etc. 

 Add up to five pages per sketch to fit in all areas of the floor plan. 

 Change the appearance of the dimensions, line width and color of 

objects you’ve drawn by selecting them and choosing Object 

Properties. 

Synchronizing with Your Desktop PC 
Any new QuickList items that have been added to WinTOTAL since the 

last time you connected will be transferred to your Pocket PC 

automatically.   

Before connecting your Pocket PC back to your computer, make sure the 

file you wish to synchronize is moved to your Synchronized folder on 

the Pocket PC.   

1. Tap File, and select the Move or Copy function.  This will open the 

File Move or Copy dialog. 
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2. Tap the option for Move or Copy, and then tap the arrow on the 

bottom right and select the Synchronized folder.   

3. Tap OK to close the dialog. 

When your Pocket PC is connected to your PC, it automatically syncs with 

the Appraisal Desktop. 

You should only keep active jobs in your Synchronized folders.  Once 

you’re past the point where an assignment needs to be synchronized, you 

should move it to a permanent location on your desktop system and 

delete it from your Pocket PC. 

Synchronization options in WinTOTAL 

To configure your synchronization options, do the following: 

1. When in a WinTOTAL report, click Tools, then Configure and then 

Pocket.  The Configuration Options dialog will display. 

2. Click Synchronization options in the Pocket pane, if it is not 

already displayed. 

 “Synchronize On Connect” is the default option.  It causes your 

desktop and Pocket PC to synchronize files each time you connect, 

regardless of whether WinTOTAL is running or not. 

 “Synchronize Manually” suppresses synchronization until you click 

the Synchronize button in Office Manager. 

 The option to Always delete corresponding reports from the 

Pocket TOTAL Synchronized folder...  is useful because it keeps 

you from having to repeat the process of moving files out of the 

Synchronization folders on both the Pocket PC and WinTOTAL.  You 

wouldn’t want to keep “finished” files in the Synchronized folders 

because they will perpetually be synchronizing! Use this option if you 

rarely have to re-edit a file on the Pocket PC after it is merged with 

the desktop. 

3. Click OK after you have selected the desired options. 

 

NOTES: 
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